
PRACTICE PAPER – 3
Max. Time: 2 Hours� Max. Marks: 50

General Instructions:
	1.	 Please read the instructions carefully.
	2.	 This Question Paper consists of 21 questions in two sections: Section A & Section B.
	3.	 Section A has Objective type questions whereas Section B contains Subjective type questions.
	4.	 Out of the given (5 + 16 = 21) questions, a candidate has to answer (5 + 10 = 15) questions in the allotted (maximum) 

time of 2 hours.
	5.	 All questions of a particular section must be attempted in the correct order.
	6.	 SECTION A—OBJECTIVE TYPE QUESTIONS (24 Marks):
			  (a)	 This section has 05 questions.
			  (b)	 Marks allotted are mentioned against each question/part.
			   (c)	 There is no negative marking.
			  (d)	 Do as per the instructions given.
	7.	 SECTION B—SUBJECTIVE TYPE QUESTIONS (26 Marks):
			  (a)	 This section has 16 questions.
			  (b)	 A candidate has to do 10 questions.
			   (c)	 Do as per the instructions given.
			  (d)	 Marks allotted are mentioned against each question/part.

SECTION A—OBJECTIVE TYPE QUESTIONS 
	 1.	 Answer any 4 out of the given 6 questions on Employability Skills.� (4 × 1 = 4 Marks)

			  (i)	 Rohan joined a multinational company where most employees come from different countries.  
He sometimes misunderstands his teammates because their accent and speaking style differ from  
what he is used to. Which of the following barriers illustrates this situation? 

	 (a)	 Physical barrier 	 (b)	 Emotional barrier 
	 (c)	 Linguistic barrier 	 (d)	 Visual barrier

	 (ii)	 Arjun constantly worries about upcoming deadlines and finds it difficult to sleep at night. His lack of rest 
makes him irritable and tired during the day. Which of the following is responsible for this condition? 

	 (a)	 Goal setting 	 (b)	 Stress 
	 (c)	 Teamwork 	 (d)	 Time management

	 (iii)	 During a virus attack, Aveer uses a program that scans his computer, detects harmful files and protects his 
data. What is this program known as? 

	 (a)	 Audio Editing Software 	 (b)	 Antivirus Software 
	 (c)	 Spreadsheet Software 	 (d)	 System Utility

	 (iv)	 Entrepreneurs often face challenges, but they continue working toward their goals with determination.  
This quality is known as _________________. 

	 (a)	 Creativity 	 (b)	 Persistence 
	 (c)	 Time Pass 	 (d)	 Routine Work

	 (v)	 Which of the SDGs focuses on creating job opportunities and improving working conditions? 
	 (a)	 Responsible Production 	 (b)	 Decent Work and Economic Growth (SDG 8)
	 (c)	 Climate Action 	 (d)	 Life Below Water

	 (vi)	 In the SMART method of goal setting, a goal should clearly define what needs to be achieved. What is this 
referring to? 

	 (a)	 Relevant 	 (b)	 Measurable 
	 (c)	 Specific 	 (d)	 Timely
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	 2.	 Answer any 5 out of the given 6 questions.	 (5 × 1 = 5 Marks)

	 (i)	 Priyal wants to apply the same character formatting (font style, size, and color) across multiple headings 
in her LibreOffice Writer document without repeating steps. Which tool should she use, and how can she 
stop using it? 

	 (a)	 Use Fill Format Mode; stop it by pressing Esc or clicking the icon again 
	 (b)	 Use AutoCorrect; stop it by closing the document 
	 (c)	 Use Styles Sidebar; stop it by pressing Ctrl+Shift+S 
	 (d)	 Use Navigator; stop it by clicking Close

	 (ii)	 Arpita applied a particular style to multiple paragraphs. Later, she decides to change the font color of that 
style so it updates everywhere automatically. After making the change to one paragraph, which option 
should she choose?

	 (a)	 New Style from Selection	 (b)	 Update Selected Style 
	 (c)	 Load Styles from Template	 (d)	 None of these

	 (iii)	 Ronit wants to insert a list of all figures used in his document, such as charts and images, along with their 
page numbers. Which feature should he use? 

	 (a)	 Table of Contents	 (b)	 Index of Tables 
	 (c)	 List of Illustrations	 (d)	 Bibliography

	 (iv)	 Assertion (A): In LibreOffice Calc, the Record Macro feature allows users to automate repetitive tasks 
without manually writing code. 

		  Reason (R): Recorded macros automatically modify and optimize the formula structure in a spreadsheet  
to increase accuracy.

	 (a)	 Both A and R are true, and R is the correct explanation of A.
	 (b)	 Both A and R are true, but R is NOT the correct explanation of A. 
	 (c)	 A is true, but R is false.
	 (d)	 A is false, but R is true.

	 (v)	 Priyanshi wants to automate calculations and test how changing individual values affects the final result, 
such as profit or total marks, repeatedly without doing the steps manually. Which tool in Calc will help 
her do this?

	 (a)	 What-if Scenarios	 (b)	 Macros
	 (c)	 Data Sort	 (d)	 Text to Columns

	 (vi)	 Which option in LibreOffice Calc allows users to enable tracking of all edits such as insertions, deletions and 
formatting changes? 

	 (a)	 File → Save As → Track Version	 (b)	 Edit → Track Changes → Record 
	 (c)	 View → Change View 	 (d)	 Tools → AutoCorrect → Enable

	 3.	 Answer any 5 out of the given 6 questions. 	 (5 × 1 = 5 Marks)

	 (i)	 Mira inserts a Table of Contents in LibreOffice Writer, but some section titles are missing. What is the MOST 
likely reason?

	 (a)	 She inserted too many images before the headings.
	 (b)	 She applied bold formatting instead of heading styles.
	 (c)	 She saved the file in .docx format.
	 (d)	 Her page margins are too narrow.

	 (ii)	 Rachna often experiences wrist pain after working on the computer for long hours. Her desk is cluttered, 
and her keyboard is placed too high. Which type of hazard is most likely responsible?

	 (a)	 Electrical Hazard	 (b)	 Ergonomic Hazard
	 (c)	 Chemical Hazard	 (d)	 Fire Hazard

	 (iii)	 In a student database, the combination of Course_ID and Roll_Number is used to uniquely identify each 
student enrolled in a course. What is this combination called?

	 (a)	 Alternate Key 	 (b)	 Composite Key 
	 (c)	 Super Key 	 (d)	 Foreign Key
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	 (iv)	 A database field defined as CHAR(30) is used to store names. If a user enters “Siya” (4 characters), how 
much space will be stored?

	 (a)	 4 bytes 	 (b)	 26 bytes 
	 (c)	 30 bytes 	 (d)	 34 bytes

	 (v)	 A company wants to store employee data in such a way that relationships can be created between 
departments, projects, and employees. Which data model is best suited?

	 (a)	 Hierarchical Data Model 	 (b)	 Network Data Model 
	 (c)	 Relational Data Model 	 (d)	 File-Based Model

	 (vi)	 For what purpose the upper part of the Query Design Window is used?
	 (a)	 Viewing query results 	 (b)	 Selecting tables and their fields 
	 (c)	 Entering SQL commands 	 (d)	 Formatting reports

	 4.	 Answer any 5 out of the given 6 questions. 	 (5 × 1 = 5 Marks)

	 (i)	 Which shortcut key combination selects the entire Writer document?
	 (a)	 Ctrl+Shift+A 	 (b)	 Ctrl+Shift+E 
	 (c)	 Ctrl+A 	 (d)	 Ctrl+Alt+A

	 (ii)	 A researcher has survey data collected weekly in separate sheets. She wants her team to view and update 
the data simultaneously without manually sending copies of the file. Which feature should she use?

	 (a)	 Inserting Hyperlink 	 (b)	 Applying Cell Referencing 
	 (c)	 Consolidating Data 	 (d)	 Sharing a Spreadsheet

	 (iii)	 Which statement about using forms in LibreOffice Base is incorrect?
	 (a)	 Forms make data entry easier for users. 	 (b)	 Forms display fields one record at a time. 
	 (c)	 Forms can be linked to tables or queries. 	 (d)	 Forms automatically generate reports from data.

	 (iv)	 Akshit works in a storeroom and frequently lifts heavy boxes. He recently complained of back pain. What 
is the most effective control measure? 

	 (a)	 Providing proper training on safe lifting techniques 
	 (b)	 Asking him to work faster 
	 (c)	 Giving him a new ID card 
	 (d)	 Installing antivirus software

	 (v)	 A school is entering student marks for different subjects in Calc. The teacher wants to automatically 
calculate the total marks for each student and display subtotals for each class. Which feature will help 
and why?

	 (a)	 Data Validation – because it restricts entries to a valid range or list 
	 (b)	 Conditional Formatting – because it highlights wrong values 
	 (c)	 Subtotals – because it automatically calculates totals and group summaries 
	 (d)	 Filter – because it hides invalid entries

	 (vi)	 A lab assistant needs to store strong acids safely. Which practice is correct? 
	 (a)	 Store acids near heat sources for quicker access 
	 (b)	 Store acids with flammable liquids 
	 (c)	 Store acids in a cool, well-ventilated corrosive-materials cabinet 
	 (d)	 Store acids on open shelves for easy handling

	 5.	 Answer any 5 out of the given 6 questions. 	 (5 x 1 = 5 marks)

	 (i)	 Anant has to perform the same sequence of formatting actions on multiple documents (change font, adjust 
margins, insert headers). Which feature will save time by automating these steps? 

	 (a)	 Styles 	 (b)	 Table of Contents 
	 (c)	 Templates 	 (d)	 Macros

	 (ii)	 Which of the following objects is used to retrieve specific data from one or more tables? 
	 (a)	 Form 	 (b)	 Query
	 (c)	 Table 	 (d)	 Report
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	 (iii)	 During an office fire alarm test, employees are instructed to leave their workstations and use the nearest 
exit to reach the safe assembly area. What is this practice known as? 

	 (a)	 Staff meeting 	 (b)	 Fire evacuation drill 
	 (c)	 Cultural rehearsal 	 (d)	 Productivity assessment

	 (iv)	 During a fire drill, a student panics and starts running. What is the correct sequence of actions for the 
teacher? 

	 (a)	 Calm the student → guide them to assembly point → report incident 
	 (b)	 Report first → leave student unattended → go to assembly point 
	 (c)	 Shout at the student → guide later → ignore incident 
	 (d)	 Allow student to run → continue drill → report next day

	 (v)	 Mohit works in a photocopy room where papers, toner bottles and wires often lie scattered on the floor. 
To reduce accidents and ensure smooth workflow, what should he prioritize? 

	 (a)	 Step over clutter carefully and continue working 
	 (b)	 Keep the floor clear, arrange wires properly, and store materials in designated shelves 
	 (c)	 Wait for housekeeping to clean everything 
	 (d)	 Hide clutter behind the machine so it is not visible

	 (vi)	 The HR department has attendance records stored separately as Jan_Attendance.ods, Feb_Attendance. 
ods and Mar_Attendance.ods. Before preparing the quarterly summary, the team wants to combine all 
three sheets into one master sheet while keeping links to source files so that updates reflect automatically. 
Which method should the data operator use? 

	 (a)	 Copy-paste data from each sheet manually into one sheet 
	 (b)	 Use Consolidate with “Link to source data” enabled 
	 (c)	 Use Find & Replace to combine monthly sheets
	 (d)	 Protect the sheets and save them together

SECTION B: SUBJECTIVE TYPE QUESTIONS
Answer any 3 out of the given 5 questions on Employability Skills. 	 (3 × 2 = 6 Marks)

	 6.	 Explain any two types of communication.

	 7.	 Samay often procrastinates and completes assignments at the last minute. Give one way he can improve his 
self-management.

	 8.	 Describe any two types of entrepreneurial activities.

	 9.	 Define sustainable agriculture and sustainable transportation.

	 10.	 Vikas connected an unknown USB drive he found in class to his laptop. Later, his files became unreadable. What 
steps could Vikram take to prevent malware infections in the future?

Answer any 4 out of the given 6 questions in 20–30 words each. 	 (4 × 2 = 8 Marks)

	 11.	 Rishika is preparing a project report in LibreOffice Writer. Her teacher asked her to describe any two  
advantages of using Paragraph Styles. What should Rishika write?

	 12.	 (a) What is the significance of adding a new comment while working on a spreadsheet? 

		  (b) How can you edit a comment that has already been added?

	 13.	 Differentiate between query and form.

	 14.	 What is an accident. Give any two ways to handle accidents.

	 15.	 Define the term Scenarios. Also, state its purpose.

	 16.	 Kavya notices that the fire alarm starts ringing during office hours and people look confused. How should she 
guide others to ensure a safe and quick evacuation?
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Answer any 3 out of the given 5 questions in 50–80 words each. 	 (3 × 4 = 12 Marks)

	 17.	 Case Study

		  A tourism company is preparing a travel brochure in LibreOffice Writer. The designer has inserted several scenic 
images, icons and decorative shapes. While finalizing the brochure, the team encounters these difficulties:

	 •	 The main scenic image at the top keeps moving whenever new text is typed below it.

	 •	 A circular logo placed near the heading is covered by the heading text whenever the page layout changes.

	 •	 In the “Places to Visit” section, the designer wants descriptions to flow evenly around each picture to make 
the page look organized.

	 •	 A watermark-style background image needs to stay behind all the text and icons on the page.
	 (a)	 Which anchoring method will keep the main scenic image from moving when text below it changes?
	 (b)	 Which wrapping option should be applied to prevent the heading text from covering the circular logo?
	 (c)	 Which text-flow option will help the descriptions wrap neatly around each picture?
	 (d)	 Which arrangement command should be used to place the watermark-style image behind all other 

elements?

	 18.	 Consider the table given below and answer the questions that follow:

Teacher_ Name Teacher_ID Department Salary
Meena Sharma T101 Maths 55000
Rajveer Verma T102 Science 62000
Simar Kaur T103 English 58000
Amar Gupta T104 Sports 60000

	 (a)	 Name all the fields in the given table.
	 (b)	 Which field should be made the primary key? 
	 (c)	 Suggest a possible alternate key, if any. Justify your answer.
	 (d)	 Explain how a primary key differs from a foreign key with an example.

	 19.	 Headaches can result from poor lighting, screen glare or long working hours. List four ways to reduce the 
chances of getting headaches while using a computer.

	 20.	 Savita is managing a School Attendance database in LibreOffice Base. She has a master table called Students 
(Student_ID, Student_Name, Class, Subject) and a transaction table called Attendance (Student_ID, 
WorkingDays, Total_attendance, Percentage).

	 (a)	 Define referential integrity and give an example from Savita’s database. 

	 (b)	 Savita wants to stop deletion of any student record that has attendance entries. Which option should she 
use? 

	 (c)	 How does the Update Cascade option work if a Student_ID is modified in the table Students? Give an 
example.

	 (d)	 Explain what happens in the table Attendance if Set NULL is used and a student record is deleted. How is 
it different from Set Default?

	 21.	 Kashvi is creating a financial report in LibreOffice Calc with multiple sheets for monthly expenses. She wants 
easy navigation and plans to import stock market tables from a financial website. She initially uses absolute 
hyperlinks but faces issues while sharing the file. She then considers relative hyperlinks. She also explores 
Target in Document and Link to External Data.

	 (a)	 Why do absolute hyperlinks break when files are shared and how do relative hyperlinks prevent this? 

	 (b)	 How does using Target in Document enhance navigation in a spreadsheet with many sheets? 

	 (c)	 Which feature allows importing live stock market data into the spreadsheet and why is it helpful? 

	 (d)	 How can Kavita edit or remove an existing hyperlink in the spreadsheet she is working with?


